
APPENDIX H: INSTRUCTIONS AND TIPS FOR USING THE PROVIDER 
MONITORING REPORT EXCEL FILES 

Two Excel files have been provided.  Both files contain the same worksheets; however: 

● Provider Monitoring Report Showing Rating Choices.xls -- This file is provided on 
the DMH/DD/SAS website Provider Monitoring page as Appendix I:  Sample Monitoring 
Report.   

This file is provided for training purposes and has been formatted to print each 
monitoring worksheet showing all the possible rating options for each element.  It is not 
intended to be used to enter the results of actual monitoring reviews.  To conserve paper 
when printing, the worksheets that contain multiple columns for documenting the results 
of multiple document reviews and interviews have been formatted to hide columns after 
the first 5 columns.  Because ratings have been entered on the monitoring worksheets 
and these worksheets are linked to the monitoring report and score sheet, the monitoring 
report and score sheet show results.  Fictitious provider and LME identifying information 
have been added to make the worksheets and monitoring report into a sample report.  
Printing the monitoring worksheets (Worksheets #1 through #6) and provider monitoring 
report worksheet provides a copy of the rating options for each monitoring worksheet 
and provides an example of what the report may look like when it is completed. 

● Provider Monitoring Report Template.xls -- This file is provided on the DMH/DD/SAS 
website Provider Monitoring page as Appendix J:  Template for the Provider Monitoring 
Tool and Report.   

This file is the report template to use to create separate provider monitoring report files 
for individual providers.  Provider and LME identifying information and ratings are blank, 
and none of the columns have been hidden.  Do not write in this file.  Instead, copy the 
file and rename it to something that will easily identify the provider being monitored and 
the date monitored (e.g. Monitoring Report - XYZ Provider 7-28-08.xls). 

File (Workbook) Layout.  The file contains 16 worksheets that have been color-coded orange, 
green, gray, or yellow according to function.  As explained below, reviewers enter identifying 
information on the “Identification” worksheet at the beginning of the workbook and their findings 
and comments on Worksheets #1 through #6.  The workbook automatically takes identifying 
information from the “Identification” worksheet and enters it into all applicable worksheets, uses 
findings to calculate ratings and points earned, completes the provider monitoring report and 
score sheet, and completes a database extract that can be copied and pasted into a provider 
monitoring database for tracking the results of all providers and multiple monitoring visits.  A one 
page diagram listing these worksheets and showing their relationship to each other is provided 
as Attachment 1 at the end of this appendix. 

The name, purpose, and instructions for using each worksheet are provided below: 

● Identification (orange color tab) -- This worksheet is provided to enter provider and 
LME identifying information and date of review.  The information entered on this 
worksheet is automatically copied to the other worksheets in the workbook (where 
appropriate) so that this information need only be entered once.   

NOTE:  the name(s) of reviewer(s) are not automatically copied to the individual 
monitoring worksheets (Worksheets #1 through #6).  The name(s) of the reviewer(s) 
must be manually entered on the top of each monitoring worksheet. 



● Provider Monitoring Report (green color tab) -- This worksheet creates the summary 
report of the results of the monitoring and shows the rating for each element, the action 
required, and comments extracted from the monitoring worksheets (Worksheets #1 
through #6).  This report is automatically generated when ratings and comments are 
entered into the individual monitoring worksheets. 

Ratings and actions required are automatically color coded (using conditional formatting) 
to make the report easier for the reader to visually scan.  Cell shading for “High” scores 
will turn green, “Moderate” scores will turn yellow, and “Low” scores will turn orange.  
The font color for the “action required” automatically changes to blue for “REC”, orange 
for “POC”, and red for “POC-FM”.  The key to the “action required” abbreviations prints 
on the footer of each page of the report. 

This worksheet is formatted to print an 11 page report to give to the Provider showing 
the results of the monitoring. 

● Ratings & Actions Summary Sheet (green color tab) -- This worksheet is a companion 
to the Provider Monitoring Report worksheet and provides a one page summary of 
ratings and actions required for each element from that worksheet.  It also provides a 
count of the number of elements rated “High”, “Moderate”, “Low”, and “Not Rated” and a 
count of the number of elements that require “No Action”, “REC”, “POC”, and “POC-FM”.  
This worksheet uses the same conditional formatting color scheme used by the Provider 
Monitoring Report worksheet to color code ratings and actions required.  This worksheet 
is automatically generated when ratings and comments are entered into the individual 
monitoring worksheets (Worksheets #1 through #6).  This worksheet should be printed 
and given to the provider as a high level summary of ratings and actions required. 

● Score Sheet (orange color tab) -- This worksheet is for internal LME use and is not 
intended to be given to the provider as part of the provider monitoring report.  It scores 
the monitoring tool and calculates the total points earned out of the 200 points possible.  
This worksheet shows the weighting that has been assigned to each domain and 
element (blue shaded cells), the number of points each is worth, the reviewers’ ratings 
(from Worksheets #1 through #6), the number of points earned for each element (based 
on the reviewer’s rating), the provider’s total points earned, and whether these points fall 
into the “High”, “Moderate”, or “Low” range.  The total points earned and performance 
range may be useful to LMEs for the purpose of setting priorities related to follow-up 
actions and for monitoring a provider’s performance and progress over time.  This 
worksheet is automatically generated when ratings are entered in the individual 
monitoring worksheets. 

If any of the elements on the monitoring worksheets (Worksheets #1 through #6) is 
marked “Not Rated”, the score sheet automatically redistributes the points for that 
element to the other elements in the domain so that the total points each domain is 
worth remains constant.  If this occurs, the worksheet shows how the points are 
redistributed. 

Should a decision be made in the future to do so, the worksheet is designed to make it 
easy to change the weighting for any of the domains or elements.  If a change is 
needed, only the numbers or percentages in the blue shaded cells should be changed.  
The worksheet will automatically adjust the points possible and scoring for the affected 
domain(s) and element(s).   

● Copy Row3 to Database (orange color tab) -- This worksheet provides a summary of 
the results for all monitoring worksheets on a single spreadsheet row in a format that 
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can be copied into an Excel database for tracking and analysis of the results of 
monitoring for multiple providers and monitoring visits.  This worksheet is linked to other 
worksheets in the file and automatically collects provider and LME identifying 
information, the date of the review, total points, the highest action required, and 
individual ratings and actions required for each element and places it on a single row for 
easy export to an external database.  This worksheet is provided to LMEs that wish to 
consolidate, track, and analyze the results of all providers they are responsible for 
monitoring. 

CAUTION:  The information on this row should be copied and the values pasted into a 
Provider Monitoring Database using the “Paste Special” command -- NOT the “Paste” 
command.  Using the “Paste Special” command to “Paste Values” will copy the actual 
values (e.g. the numbers and words that appear on this row) into the database.  In 
contrast, the “Paste” command will copy only the formulas and links to the database 
rather than the values generated by those formulas and links and may cause the 
database to not work properly. 

● Database (yellow color tab) -- This worksheet provides a database that can be used to 
consolidate, track, and analyze the results of provider monitoring visits for multiple 
providers or multiple reviews.  It is designed to receive the data generated by the 
“Copy Row3 to Database” worksheet from the many provider monitoring files that will be 
created for the individual reviews. 

It is recommended  that this worksheet be copied or moved to another Excel file that 
will serve as the database.   

When copying this worksheet to another Excel file that will serve as a provider 
monitoring database file, the easiest and most effective way to copy this worksheet is to 
use the shortcut menu associated with the worksheet tab at the bottom of the worksheet.  
Using this method will maintain the column width and row height formatting and print 
settings from the source file. 

To copy the database, do the following: 

o Right click on the yellow colored worksheet tab (named “Database”) at the 
bottom of the worksheet.  (This will cause a shortcut menu to appear) 

o On the shortcut menu, select (left click) “Move or Copy…”.  (This will cause the 
Move or Copy dialogue box to appear) 

o In the “To book:” drop-down box at the top of the dialogue box, select “(new 
book)”. 

o Check the “Create a copy” checkbox at the bottom of the dialogue box.  (If you 
leave this checkbox blank, the worksheet will be moved to the new file instead of 
copied to it.) 

o Select (left click) the “OK” button at the bottom of the dialogue box, or press 
“Enter” on your keyboard. 

o A warning message will pop-up on your screen informing you:  “The sheet you 
are copying has cells that contain more than 255 characters.  When you copy the 
entire sheet, only the first 255 characters in each cell are copied.  To copy all of 
the characters, copy the cells to a new sheet instead of copying the entire sheet.” 
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o Select (left click) the “OK” button on the warning message.  (The warning 
message will disappear, and the worksheet will be copied into a new Excel 
workbook -- with some of the cells truncated at 255 characters.) 

o To fix the truncation problem, unprotect the worksheet in the new workbook. 

o Return to the source file from which you copied the “Database” worksheet. 

o Left click the blank gray-colored cell at the top left corner of the worksheet at 
the intersection of the gray-colored column and row headers (above row 1 and to 
the left of column A).  (This will select and highlight all cells in the source file 
worksheet.) 

o Copy the source file worksheet to Excel’s clipboard (there are multiple ways to 
do this -- press the “Copy” shortcut button on the toolbar, use the Edit drop-down 
menu and select “Copy”, or press the “Ctrl” and “C” keys simultaneously). 
(Flashing dotted lines will appear around the borders of the worksheet showing 
that everything has been copied to the clipboard.  This includes data from cells 
that exceed 255 characters.) 

o Return to the new workbook (destination file) that you created earlier. 

o  Left click the blank gray-colored cell at the top left corner of the worksheet at 
the intersection of the gray-colored column and row headers (above row 1 and to 
the left of column A).  (This will select and highlight all cells in the destination file 
worksheet.) 

o Paste the information that was copied to the clipboard onto the destination 
worksheet (there are multiple ways to do this -- press the “Paste” shortcut button 
on the toolbar, use the Edit drop-down menu and select “Paste”, or press the 
“Ctrl” and “V” keys simultaneously).  (The “Database” worksheet in the 
destination file will now be identical to the “Database” worksheet from the source 
file) 

o Protect the destination worksheet in the new workbook. 

o Save and name the new workbook file with your database. 

The values copied from the “Copy Row3 to Database” worksheet of individual provider 
monitoring files should be pasted into this database using the “Paste Special” command 
to “Paste Values” as described above in the “CAUTION” section of the “Copy Row3 to 
Database” worksheet description. 

The data for the results of multiple providers and reviews can be analyzed using the 
built-in “autofilters” on row 4 of the database combined with the “subtotal” formulas on 
row 2 of the database.  The database can also be analyzed using pivot tables (not 
provided). 

 “Autofilters” allow one to search for specific records (rows) or for records that meet 
specific criteria or conditions.  “Autofilters” automatically hide rows that do not meet the 
criteria or conditions filtered and show only those records that meet the criteria or 
condition.   

The “subtotal” formulas work with “autofilters” to count, sum or average values 
(depending upon which variation of the formula is used) for the entries that meet the 
criteria or conditions designated by the “autofilters” selected.  The subtotal formulas 
evaluate the values for the first 35,000 rows of the database.  The formulas can be 
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adjusted if the rows of data entered into the database exceed 35,000 rows.  However, it 
is not expected that this will need to be done. 

The database has been conditionally formatted to show “ratings” and “actions required” 
using the same color scheme used by the Provider Monitoring Report worksheet. 

Additional columns can be added to the database, as needed, to allow LMEs to collect 
and analyze additional information related to provider monitoring. 

● #1 Provider Documentation (gray color tab) -- This worksheet is the first of the provider 
monitoring worksheets to be used by reviewers for entering monitoring results.  It is 
designed to evaluate organizational elements of the provider’s operations and as such 
has one column for entering findings.   

Enter the name(s) of the reviewer(s) responsible for completing this worksheet in the 
appropriate cell at the top of the worksheet.  If nothing is entered (i.e. the cell is blank), 
the cell will be highlighted yellow and a reminder (in blue font) will appear next to the 
cell. 

To enter a rating for each subelement, if worksheet protection is turned on, double-click 
the corresponding cell in the “Rating” column and select a rating from the drop-down 
menu provided.  The worksheet will automatically calculate an overall “rating” for the 
element and will enter this “rating” in the appropriate place on the “Provider Monitoring 
Report” worksheet. 

Enter relevant comments or notes in the cell provided for “Comments & Notes”.  
Comments entered here will automatically be entered in the “Comments” column for the 
element in the “Provider Monitoring Report” worksheet.  Comments are required if the 
element is rated “Not Rated” or receives less than full credit.  If this is the case, and a 
comment has not been entered, the “Comments & Notes” row will turn yellow. 

Print this worksheet to provide details how each subelement reviewed was rated and 
how the overall rating for the element was calculated. 

● #2 Personnel Documentation (gray color tab) -- This worksheet is the second of the 
provider monitoring worksheets to be used by reviewers for entering monitoring results.  
It is designed to evaluate a sample of personnel records and has 30 columns for 
entering findings (labeled Staff #1, Staff #2, etc).  Depending on the size of the 
provider’s organization and the number of services being monitored, it is possible that 
not all columns will be needed.  The worksheet is designed to print 5 columns per page.  
To conserve paper when printing, hide unused columns in groups of 5 (e.g. Staff #6 - 
#10, Staff #11 - #15, etc) prior to printing.  Do not hide the last column labeled “Rating”.  
This column needs to be included in the report when printed.  

Enter the name(s) of the reviewer(s) responsible for completing this worksheet in the 
appropriate cell at the top of the worksheet.  If nothing is entered (i.e. the cell is blank), 
the cell will be highlighted yellow and a reminder (in blue font) will appear next to the 
cell. 

To enter a rating for each subelement, if worksheet protection is turned on, double-click 
the corresponding cell in the appropriate column (labeled Staff #1, Staff #2, etc), and 
select a rating from the drop-down menu provided.  The worksheet will automatically 
calculate an overall “rating” for the element and will enter this “rating” in the appropriate 
place on the “Provider Monitoring Report” worksheet.   

If for some reason all documents in the sample are “Not Rated” for a given subelement, 
it is only necessary to enter “Not Rated” in one of the cells on this row.  The other cells 
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on this row can be left blank.  The worksheet will see the one “Not Rated” on the row 
and will calculate the subelement as “Not Rated”. 

Enter relevant comments or notes in the cell provided for “Comments & Notes”.  
Comments entered here will automatically be entered in the “Comments” column for the 
element in the “Provider Monitoring Report” worksheet.  Comments are required if the 
element was rated “Not Rated” or received less than full credit.  If this is the case, and a 
comment has not been entered, the “Comments & Notes” row will turn yellow. 

As was mentioned earlier, this worksheet is formatted to print 5 columns per page.  This 
was done to accommodate cases where up to 5 records per service might be reviewed.  
The cells in the “Comments & Notes” row for these 5 columns have been merged to 
facilitate entry of any comments and notes for this sample. 

Print this worksheet to provide details how each subelement reviewed was rated and 
how the overall rating for the element was calculated. 

● #3 Personnel Interview (gray color tab) -- This worksheet is the third of the provider 
monitoring worksheets to be used by reviewers for entering monitoring results.  It is 
designed to evaluate data obtained from a sample of staff interviews and has 10 
columns for entering findings (labeled Interview #1, Interview #2, etc).  Depending on the 
size of the provider’s organization and the number of services being monitored, it is 
possible that not all columns will be needed.  The worksheet is designed to print 5 
columns per page.  To conserve paper when printing, hide unused columns in groups of 
5 (e.g. Interview #6 - #10) prior to printing.  Do not hide the last column labeled “Rating”.  
This column needs to be included in the report when printed.  

Enter the name(s) of the reviewer(s) responsible for completing this worksheet in the 
appropriate cell at the top of the worksheet.  If nothing is entered (i.e. the cell is blank), 
the cell will be highlighted yellow and a reminder (in blue font) will appear next to the 
cell. 

To enter a rating for each element/subelement, if worksheet protection is turned on, 
double-click the corresponding cell in the appropriate column (labeled Interview #1, 
Interview #2, etc), and select a rating from the drop-down menu provided.  The 
worksheet will automatically calculate an overall “rating” for the element and will enter 
this “rating” in the appropriate place on the “Provider Monitoring Report” worksheet.   

If for some reason all interviews in the sample are “Not Rated” for a given subelement, it 
is only necessary to enter “Not Rated” in one of the cells on this row.  The other cells on 
this row can be left blank.  The worksheet will see the one “Not Rated” on the row and 
will calculate the subelement as “Not Rated”. 

Enter relevant comments or notes in the cell provided for “Comments & Notes”.  
Comments entered here will automatically be entered in the “Comments” column for the 
element in the “Provider Monitoring Report” worksheet.  Comments are required if the 
element was rated “Not Rated” or received less than full credit.  If this is the case, and a 
comment has not been entered, the “Comments & Notes” row will turn yellow. 

As was mentioned earlier, this worksheet is formatted to print 5 columns per page.  This 
was done to accommodate cases where up to 5 records per service might be reviewed.  
The cells in the “Comments & Notes” row for these 5 columns have been merged to 
facilitate entry of any comments and notes for this sample. 

Print this worksheet to provide details how each element/subelement reviewed was 
rated and how the overall rating for the element was calculated. 
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● #4 Individual Record (gray color tab) -- This worksheet is the fourth of the provider 
monitoring worksheets to be used by reviewers for entering monitoring results.  It is 
designed to evaluate a sample of individual records and has 30 columns for entering 
findings (labeled Record #1, Record #2, etc).  Depending on the size of the provider’s 
organization and the number of services being monitored, it is possible that not all 
columns will be needed.  The worksheet is designed to print 5 columns per page.  To 
conserve paper when printing, hide unused columns in groups of 5 (e.g. Record #6 - 
#10, Record #11 - #15, etc) prior to printing.  Do not hide the last column labeled 
“Rating”.  This column needs to be included in the report when printed.  

Enter the name(s) of the reviewer(s) responsible for completing this worksheet in the 
appropriate cell at the top of the worksheet.  If nothing is entered (i.e. the cell is blank), 
the cell will be highlighted yellow and a reminder (in blue font) will appear next to the 
cell. 

To enter a rating for each element/subelement, if worksheet protection is turned on, 
double-click the corresponding cell in the appropriate column (labeled Record #1, 
Record #2, etc), and select a rating from the drop-down menu provided.  The worksheet 
will automatically calculate an overall “rating” for the element and will enter this “rating” in 
the appropriate place on the “Provider Monitoring Report” worksheet.   

If for some reason all records in the sample are “Not Rated” for a given subelement, it is 
only necessary to enter “Not Rated” in one of the cells on this row.  The other cells on 
this row can be left blank.  The worksheet will see the one “Not Rated” on the row and 
will calculate the subelement as “Not Rated”. 

Enter relevant comments or notes in the cell provided for “Comments & Notes”.  
Comments entered here will automatically be entered in the “Comments” column for the 
element in the “Provider Monitoring Report” worksheet.  Comments are required if the 
element was rated “Not Rated” or received less than full credit.  If this is the case, and a 
comment has not been entered, the “Comments & Notes” row will turn yellow. 

As was mentioned earlier, this worksheet is formatted to print 5 columns per page.  This 
was done to accommodate cases where up to 5 records per service might be reviewed.  
The cells on the “Comments & Notes” row for these 5 columns have been merged to 
facilitate entry of any comments and notes for this sample. 

Print this worksheet to provide details how each element/subelement reviewed was 
rated and how the overall rating for the element was calculated. 

● #5 Individual Interview (gray color tab) -- This worksheet is the fifth of the provider 
monitoring worksheets to be used by reviewers for entering monitoring results.  It is 
designed to evaluate data obtained from a sample of interviews with consumers and/or 
their legally responsible person.  It has 10 columns for entering findings (labeled Record 
#1, Record #2, etc).  The column is labeled to identify the Record # of the consumer that 
is the subject of the interview.  Depending on the size of the provider’s organization and 
the number of services being monitored, it is possible that not all columns will be 
needed.  The worksheet is designed to print 5 columns per page.  To conserve paper 
when printing, hide unused columns in groups of 5 (e.g. Record #6 - #10) prior to 
printing.  Do not hide the last column labeled “Rating”.  This column needs to be 
included in the report when printed.  

Enter the name(s) of the reviewer(s) responsible for completing this worksheet in the 
appropriate cell at the top of the worksheet.  If nothing is entered (i.e. the cell is blank), 
the cell will turn yellow and a reminder (in blue font) will appear next to the cell. 
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To enter a rating for each element/subelement, if worksheet protection is turned on, 
double-click the corresponding cell in the appropriate column (labeled Record #1, 
Record #2, etc), and select a rating from the drop-down menu provided.  The worksheet 
will automatically calculate an overall “rating” for the element and will enter this “rating” in 
the appropriate place on the “Provider Monitoring Report” worksheet.   

If for some reason all interviews in the sample are “Not Rated” for a given subelement, it 
is only necessary to enter “Not Rated” in one of the cells on this row.  The other cells on 
this row can be left blank.  The worksheet will see the one “Not Rated” on the row and 
will calculate the subelement as “Not Rated”. 

Enter relevant comments or notes in the cell provided for “Comments & Notes”.  
Comments entered here will automatically be entered in the “Comments” column for the 
element in the “Provider Monitoring Report” worksheet.  Comments are required if the 
element was rated “Not Rated” or received less than full credit.  If this is the case, and a 
comment has not been entered, the “Comments & Notes” row will turn yellow. 

As was mentioned earlier, this worksheet is formatted to print 5 columns per page.  This 
was done to accommodate cases where up to 5 records per service might be reviewed.  
The cells in the “Comments & Notes” row for these 5 columns have been merged to 
facilitate entry of any comments and notes for this sample. 

Print this worksheet to provide details how each element/subelement reviewed was 
rated and how the overall rating for the element was calculated. 

● #6 Incidents & Complaints (gray color tab) -- This worksheet is the sixth and final 
provider monitoring worksheet to be used by reviewers for entering monitoring results.  It 
is designed to evaluate a sample of incidents and complaints and has 15 columns for 
entering findings (labeled Sample #1, Sample #2, etc).  Depending on the size of the 
provider’s organization and the number of services being monitored, it is possible that 
not all columns will be needed.  The worksheet is designed to print 5 columns per page.  
To conserve paper when printing, hide unused columns in groups of 5 (e.g. Sample #6 - 
#10 or Sample #11 - #15) prior to printing.  Do not hide the last column labeled “Rating”.  
This column needs to be included in the report when printed.  

Enter the name(s) of the reviewer(s) responsible for completing this worksheet in the 
appropriate cell at the top of the worksheet.  If nothing is entered (i.e. the cell is blank), 
the cell will be highlighted yellow and a reminder (in blue font) will appear next to the 
cell. 

To enter a rating for each element/subelement, if worksheet protection is turned on, 
double-click the corresponding cell in the appropriate column (labeled Sample #1, 
Sample #2, etc), and select a rating from the drop-down menu provided.  The worksheet 
will automatically calculate an overall “rating” for the element and will enter this “rating” in 
the appropriate place on the “Provider Monitoring Report” worksheet.   

If for some reason all documents in the sample are “Not Rated” for a given subelement, 
it is only necessary to enter “Not Rated” in one of the cells on this row.  The other cells 
on this row can be left blank.  The worksheet will see the one “Not Rated” on the row 
and will calculate the subelement as “Not Rated”. 

Enter relevant comments or notes in the cell provided for “Comments & Notes”.  
Comments entered here will automatically be entered in the “Comments” column for the 
element in the “Provider Monitoring Report” worksheet.  Comments are required if the 
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element was rated “Not Rated” or received less than full credit.  If this is the case, and a 
comment has not been entered, the “Comments & Notes” row will turn yellow. 

As was mentioned earlier, this worksheet is formatted to print 5 columns per page.  This 
was done to accommodate cases where up to 5 records per service might be reviewed.  
The cells in the “Comments & Notes” row for these 5 columns have been merged to 
facilitate entry of any comments and notes for this sample. 

Print this worksheet to provide details how each element/subelement reviewed was 
rated and how the overall rating for the element was calculated. 

● Rating Choices (orange color tab) -- This worksheet was created as a reference for 
reviewers who may not have access to a computer during the monitoring visit and who 
must instead use printed worksheets to document findings.  This worksheet lists the 
elements/subelements contained in the 6 provider monitoring worksheets (Worksheets 
#1 through #6) and all possible rating choices for each.  It can be printed and carried as 
a reference guide. 

An alternative to printing this worksheet is to print Worksheets #1 through #6 from the 
file named “Provider Monitoring Report Showing Rating Choices.xls”.  As explained 
earlier, this file is formatted to print the first 5 columns of each provider monitoring 
worksheet and shows all possible rating choices for each element/subelement on the 
actual monitoring worksheet. 

The difference between the two options is: 

o The “Rating Choices” worksheet does not look exactly like the provider 
monitoring worksheets.  It contains the information about the element/ 
subelement in the Documentation or Interview column (second column), and it 
contains the possible rating choices for each. It does not contain the “Key 
Elements” column (first column), “Comments & Notes” rows, or “Rating” column 
(last column).  It is 8 printed pages. 

o The “Provider Monitoring Report Showing Rating Choices.xls” file prints the 
6 provider monitoring worksheets exactly as they appear in the report along with 
all possible rating choices shown on each worksheet.  It is 20 printed pages. 

Both options are offered for reviewer convenience. 

● Ratings and Actions Required (orange color tab) -- This worksheet is provided for 
information only.  It provides a one page table summarizing the “Action Required” for 
each key element for each possible rating and shows the cutoff for a “Low” rating.  The 
formulas in the “Action Required” column of the Provider Monitoring Report worksheet 
automatically display the action required shown in this table. 

As the table shows, a “High” rating or “Not Rated” uniformly requires no action.  
However, the actions required for “Moderate” and “Low” ratings are not uniform.  They 
vary for each key element depending on the nature of the element.  For example, for key 
element “1A1 - QM Plan (Documentation)”, both a “Moderate” and a “Low” rating 
require a “POC” (Plan of Correction).  However, for key element “1A2 - QM 
Plan/Activities (Staff Understanding)”, both a “Moderate” and a “Low” rating require 
only a “REC” (Recommendation for Improvement).   

The table shows the cutoff for a low rating for each key element.  For monitoring 
worksheet #1, the ratings are based on “qualitative” criteria.  For the other monitoring 
worksheets (#2 - #6), the ratings are generally based on the percentage of records 
reviewed or interviews conducted that meet criteria.  
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As the table shows, several key elements allow only two possible ratings - “High” or 
“Low”.  There is no “Moderate” rating for these elements.  In these cases, the cutoff 
percentage for a “Low” rating is higher than that required for the other key elements. 

● Effective Sample Size 1-10 (orange color tab) -- This worksheet provides a table 
showing the effect of sample size on ratings for elements whose rating relies on the 
percentage of documents reviewed or interviews conducted that meet criteria.  This table 
shows the number that must meet criteria for sample sizes ranging from 1 - 10 in order 
to receive the “High”, “Moderate”, and “Low” ratings.  It is provided for information only. 

● Effective Sample Size 1-25 (orange color tab) -- This worksheet provides a table 
showing the effect of sample size on ratings for elements whose rating relies on the 
percentage of documents reviewed or interviews conducted that meet criteria.  This table 
shows the number that must meet criteria for sample sizes ranging from 1 - 25 in order 
to receive the “High”, “Moderate”, and “Low” ratings.  It is provided for information only. 

Helpful Hints. 

● Colored Worksheet Tabs.   As noted in the preceding section, some of the worksheets 
in the file have different color tabs.   

o The green-tabbed worksheets are part of the Provider Monitoring Report and 
are printed and provided to the provider following the monitoring visit.  They 
provide summary information at the element level and are automatically 
completed from information entered into the six monitoring worksheets. 

o The gray-tabbed worksheets are the individual provider monitoring worksheets 
(Worksheet #1 through #6) that are completed by the reviewers during the 
monitoring visit.   These worksheets contain the detailed information about the 
subelements and their ratings that are used to generate the green-tabbed 
summary report.  These worksheets may also be printed and attached to the 
report to allow the provider to “drill down” for more details about how the ratings 
were derived. 

o The orange-tabbed worksheets are for internal LME use or information.  They 
include a worksheet for entering identifying information about the provider and 
LME that automatically enters this information on other worksheets, a worksheet 
that provides summary information in a format that can be easily copied and 
entered into a database for tracking the results of monitoring for all providers, a 
score sheet for calculating points earned on the tool, and reference sheets 
providing rating choices and tables showing the effect of sample size on ratings. 

o The yellow-tabbed worksheet identifies the worksheet that can be copied or 
moved to another file and used as a database for tracking the results of provider 
monitoring for multiple providers and reviews. 

● Use of Worksheet Protection.  Worksheet Protection has been turned on for each 
worksheet to protect formulas, links and important information from being inadvertently 
deleted or copied over.  Cells where information can be entered have been unlocked to 
allow data entry when worksheet protection is turned on.  Protection has been formatted 
to allow users to change the formatting for rows and columns without the need to turn 
protection off.  For example users can hide/unhide columns or change the row height or 
column width (if needed) to adjust the way the worksheets print.  On the database 
worksheet, the worksheet can be filtered and sorted while protection is on.   
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Worksheet Protection has not been password protected.  It can be turned on and off at 
will.  If it must be turned off for any reason, be careful not to change or delete anything 
important, and be sure to re-protect the worksheet as soon as possible. 

● Viewing the Worksheets Using Different Monitors.  Due to the use of text wrapping, 
the row heights on each worksheet vary depending on the content.  This may pose a 
challenge to some users who may have small or low-resolution computer monitors.  For 
individuals in this situation, some rows may appear to be almost as high as the screen 
making it difficult to smoothly scroll from row to row.   

If this is the case and becomes a problem, reduce the percentage on the “zoom” 
shortcut button on the Excel toolbar to reduce the viewing size of the worksheet on the 
monitor.  This will make each row appear smaller and may make it easier to scroll.  Only 
the viewing size that appears on the monitor will be affected.   

This technique can also be used to view more of the worksheet on the monitor.  
Adjusting the zoom on the Excel toolbar does not affect the size of the report that is 
printed.  Adjusting the zoom is worksheet-specific and only affects the worksheet for 
which the zoom has been adjusted. 

● Entering Monitoring Results When Multiple Reviewers Are Involved.  Several 
possible approaches are offered for consideration.  Feel free to choose the approach or 
combination of approaches that best meets your needs or situation. 

o Approach 1.  Print a copy of the relevant monitoring tool worksheets and rating 
choices reference guide for each reviewer.   

During the monitoring visit, each reviewer can write ratings and comments on the 
printed copy and can attach additional notes and/or copies of relevant supporting 
documents/records, as needed.   

Each reviewer can later enter ratings and relevant comments into the Excel 
workbook.  One reviewer enters, followed by the second reviewer, etc. 

The report is printed and given to the provider, and a file copy is saved along with 
worksheets, notes and supporting documents. 

o Approach 2.  Same as Approach 1, except that one person is designated to 
enter the results for all reviewers into the Excel workbook.  Each reviewer 
provides that person a copy of the printed worksheet, then reviews the final 
document to ensure accuracy. 

o Approach 3.  Each reviewer brings a laptop computer and enters ratings and 
relevant comments for assigned portions of the review directly into separate 
copies of the Excel workbook at the time of the monitoring review or immediately 
following the review.  

After each reviewer separately enters ratings and comments into their own file, 
one of the files is designated as the master file.  Ratings and comments from the 
other file(s) are copied and pasted into the master file to create a single report. 

To facilitate this process, it would make it easiest to copy and paste if each 
reviewer would complete an entire monitoring worksheet and/or complete related 
worksheets (e.g. one reviewer complete Worksheet #2 Personnel Documentation 
and Worksheet #3 Personnel Interview, another reviewer complete Worksheet #4 
Individual Record and Worksheet #5 Individual Interview, and another reviewer 
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complete Worksheet #1 Provider Documentation and Worksheet #6 Incidents & 
Complaints).   

If this is not possible, and more than one reviewer must work in the same 
monitoring worksheet, it would facilitate copying and pasting ratings and 
comments if each reviewer would divide the workload into multiples of five 
records or interviews (e.g. one reviewer complete records or interviews 1-5, 
another reviewer complete records or interviews 6-10, etc.).  The reason for this 
approach is that comments in Worksheets #2 through #6 are merged across 
multiples of five columns.  It is easier to copy and paste multiples of five columns 
and associated comments than it is to split these columns and to separate and/or 
append comments. 

o Approach 4.  Convert a copy of the Excel Provider Monitoring Report workbook 
into a “shared workbook”, which will allow multiple reviewers to enter ratings 
and comments into the same file at the same time (as long as ratings and 
comments are not entered into the same cells).   

In order to use this approach, the shared workbook must be placed on a shared 
network drive to which all reviewers have access. 

In addition, if multiple reviewers plan to work in the same worksheet, each will 
need to coordinate in advance and agree on which columns to complete to 
ensure that ratings and comments are not entered into the same cells.  The best 
way to do this is to divide the columns among reviewers in multiples of five 
containing merged comments (e.g. record/document/interview numbers 1-5, 6-
10, 11-15, etc.).  

If reviewers plan to use this approach to enter findings while “in the field”, each 
reviewer will need to be able to access the shared network drive from that 
location. 

Information and tips on using shared workbooks (copied from Microsoft’s 
website) is provided as Attachment 2 at the end of this appendix. 



ATTACHMENT 1:  PROVIDER MONITORING REPORT - EXCEL WORKBOOK LAYOUT 

The workbook contains the following 16 worksheets (color-coded orange, green, gray or yellow): 

 

● Identification 

● Provider Monitoring Report 

● Ratings & Actions Summary Sheet 

● Score Sheet 

● Copy Row3 to Database 

● Database 

● #1 Provider Documentation 

● #2 Personnel Documentation 

● #3 Personnel Interview 

● #4 Individual Record 

● #5 Individual Interview 

● #6 Incidents & Complaints 

● Rating Choices 

● Ratings and Actions Required 

● Effective Sample Size 1-10 

These two worksheets are 
printed and given to the provider 
as the monitoring report.  They 
provide summary information at 
the element level and are 
automatically created from 
information entered into the 6 
monitoring worksheets. 

These six worksheets are used 
to enter the monitoring findings.  
They contain detailed 
information at the sub-element 
level that is used to generate 
ratings for each element.  
Results are automatically copied 
to the worksheets shown by the 
arrows.  They may be printed 
and given to the provider as 
attachments to the report. 
 
NOTE:  Need to enter name(s) of 
reviewer(s) at the top of each 
worksheet. 

 
Orange colored worksheets are 

for LME information and use. 

Information entered is automatically 
copied to appropriate worksheets.

● Effective Sample Size 1-25 

The yellow colored Database 
worksheet may be moved to 
another file where it can be used 
to track summary information for 
all providers monitored. 



ATTACHMENT 2:  INFORMATION AND TIPS ON USING SHARED WORKBOOKS 

 
Sign in to My Office Online (What's this?) | Sign in 

 
 

Microsoft Office Excel 
Home  >  Products  >  Excel  >  Excel 2003 Help and How-to  >  Excel for your job  >  
Finance 
 

Community Tips Email this link Printer-Friendly Version Share 
Collaborate on accounting functions by using shared workbooks 
Applies to: Microsoft Office Excel 2003 
  

Hide All

Performing accounting functions, such as financial reporting, budgeting, and analysis, 
usually requires a great deal of collaboration. For example, people from different 
departments often need to submit budget requests for the coming year. How do you 
consolidate all that information? 

If you have everyone fill out a separate worksheet and submit it to you, the results have 
to be compiled before you can use them. This process is time-consuming, and it can 
also introduce errors. 

As an alternative, you can have people enter the information directly into your 
workbook. But if you pass an unprotected workbook around the group, you might find 
some surprises in your formulas and other items by the time the workbook gets back to 
you — assuming you even get it back in time to meet your deadlines. 

How can you let multiple users enter information into the same workbook at the same 
time, protect formulas from unintended or unauthorized changes, and keep track of the 
changes made by each person? Easy. Use a shared workbook (shared workbook: A 
workbook set up to allow multiple users on a network to view and make changes at the 
same time. Each user who saves the workbook sees the changes made by other 
users.). 

Shared workbooks 

In Microsoft Office Excel 2003, you can set up a workbook to be shared so that multiple 
users on a network can work on it simultaneously. You decide who can access the 
workbook, what level of access each user has, and what they can see and change. 
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Create a workbook 

First, create the workbook that you want to share. Set up tables, create formulas, and 
do as much as possible before you share the workbook. For example, this budget 
request workbook is set up and is ready for team input. 

 

Some features, such as merged cells and PivotTable® reports, can't be changed when 
a workbook is shared, so make sure to create them before you share the workbook. If 
you need to use these features after you share the workbook, you can save and 
unshare the workbook, and then work as usual. 

What features can't be changed while a workbook is shared? 

 Merged cells 
 Conditional formats 
 Data validation 
 Charts 
 Pictures 
 Objects (including drawing objects) 
 Hyperlinks 
 Scenarios 

javascript:ToggleDiv('divExpCollAsst_1')


 Outlines 
 Subtotals 
 Data tables 
 PivotTable® reports 
 Workbook and worksheet protection 
 Macros 

How do I unshare a workbook? 

1. Have all other users save and close the shared workbook.  

 Caution   If other users are revising the workbook when you unshare it, they 
lose any unsaved work. Also, unsharing the workbook deletes the change 
history (change history: In a shared workbook, information that is maintained 
about changes made in past editing sessions. The information includes the name 
of the person who made each change, when the change was made, and what 
data was changed.). If you want to keep a copy of this information, print out the 
History worksheet (History worksheet: A separate worksheet that lists changes 
being tracked in a shared workbook, including the name of the person who made 
the change, when and where it was made, what data was deleted or replaced, 
and how conflicts were resolved.) or copy it to another workbook. 

How? 

1. On the Tools menu, point to Track Changes, and then click Highlight 
Changes. 

2. In the When box, click All. 
3. Clear the Who and Where check boxes. 
4. Select the List changes on a new sheet check box, and then click OK. 
5. Do one or more of the following: 

 To print the History worksheet, click Print . 
 To copy the history to another workbook, select the cells you want 

to copy, click Copy , switch to another workbook, click where 

you want the copy to go, and click Paste . 

 Note   You might also want to save or print the current version of the 
workbook, because this history might not apply to later versions. For 
example, cell locations, including row numbers, in the copied history might 
no longer be current. 

2. On the Tools menu, click Share Workbook, and then click the Editing tab. 
3. Make sure that you are the only person listed in the Who has this workbook 

open now box. 
4. Clear the Allow changes by more than one user at the same time check box.
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If this check box is not available, you must unprotect the workbook before 
clearing the check box. 

How? 

1. Click OK, point to Protection on the Tools menu, and then click 
Unprotect Shared Workbook. 

2. Enter the password (password: A way to restrict access to a workbook, 
worksheet, or part of a worksheet. Excel passwords can be up to 255 
letters, numbers, spaces, and symbols. You must type uppercase and 
lowercase letters correctly when you set and enter passwords.) if 
prompted, and then click OK. 

3. On the Tools menu, click Share Workbook, and then click the Editing 
tab. 

5. When prompted about the effects on other users, click Yes. 

Protect your workbook from unintended or unauthorized changes 

You have several options for setting limits on how users can view or change your 
workbook. You can restrict access at the workbook level or the worksheet level, you can 
choose which cells users can change, and you can even let certain users make 
changes and other users only view the workbook. 

Protect at the workbook level 

When you protect a workbook, you can protect the structure of the workbook and the 
size and position of workbook windows. 

1. On the Tools menu, click Protection. 
2. Select the Structure check box if you want to restrict these structure changes: 

o Viewing hidden worksheets 
o Inserting new worksheets or chart sheets 
o Moving, deleting, hiding, or changing worksheet names 
o Moving or copying worksheets to another workbook 
o Displaying the source data for a cell in the data area of a PivotTable® 

report 
o Displaying page field pages of a PivotTable report on a separate 

worksheet 
o Creating a scenario summary report 
o Using tools from the Analysis ToolPak to place results on a new 

worksheet 
o Running macros that include an operation that can't be performed in a 

protected workbook 
3. Select the Windows check box to prevent users from changing the size and 

position of the windows for the workbook when the workbook is opened and to 
prevent users from moving, resizing, or closing the windows. Users can still hide 
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and unhide windows. 
4. Enter a password. The password is optional, but a workbook protected without a 

password can be easily unprotected and changed. Be sure to choose a 
password you can remember, because if you lose the password, you cannot gain 
access to the protected elements on the worksheet. 

5. Click OK. 

Protect at the worksheet level 

At the worksheet level, you can prevent users from inserting, deleting, and formatting 
rows and columns, from changing the contents of locked cells, and from moving the 
pointer to cells that are locked or to cells that are unlocked. 

1. Switch to the worksheet you want to protect. 
2. Unlock any cells you want users to be able to change. By default, all cells are 

locked when the worksheet is protected. 

How? 

In this example, you want the users to enter values in cell C3 through cell C6. 

Cells to be unlocked 

 

1. Select the cell or range you want to unlock. 
2. On the Format menu, click Cells. 
3. On the Protection tab, clear the Locked check box. 

3. Hide any formulas that you don't want to be visible.  

 Note   You do not need to hide formulas to protect them. 

How? 

1. Select the cells with the formulas that you want to hide. 
2. On the Format menu, click Cells. 
3. On the Protection tab, select the Hidden check box. 

4. On the Tools menu, point to Protection, and then click Protect Sheet. 
5. Type a password for the sheet (optional). 
6. In the Allow all users of this worksheet to list, select the elements that you 
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want users to be able to change. In this example, users are able to insert 
columns and rows. 

 

7. Click OK, and if prompted, retype the password. 

Share your workbook with other users 

Next, save your workbook to a network location that the other users have access to. 

1. On the Tools menu, click Share Workbook, and then click the Editing tab. 
2. Select the Allow changes by more than one user at the same time check box.
3. Click the Advanced tab. 
4. Under Track changes, click Keep change history for, and in the Days box, 

type the number of days of change history that you want to keep. 

 Important   Excel permanently erases any change history older than the value 
you set here, so make sure to specify the longest change history period you will 
ever need. 

5. Click OK, and if prompted to save the file, click OK. 
6. On the File menu, click Save As, and then save the workbook on a network 

location accessible to the intended users. Use a shared network folder, not a 
Web server. 

Work in a shared workbook 
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After you open a shared workbook, you can enter and change data as you would in a 
regular workbook. When you save the shared workbook, you're updated with any 
changes that others have saved since the last time you saved the workbook. If you want 
to keep the shared workbook open to monitor progress, you can set Excel to notify you 
with changes automatically, at timed intervals that you specify, with or without saving 
the workbook yourself. 

1. On the Tools menu, click Share Workbook. 
2. Click the Advanced tab, and under Update changes, select the options you 

want. 

Resolve conflicts 

When two or more people are working simultaneously in the same workbook, sooner or 
later they're going to change the same cell. When this happens, the Resolve Conflicts 
dialog box opens so that you can decide which changes to keep. In this example, both 
you and Nancy changed cell C3. 

 

1. Read the information about each change and the conflicting changes made by 
others. 

2. To save the change you want and go to the next conflicting change, click Accept 
Mine or Accept Other. 

3. To keep all of your remaining changes or all of the other users' changes, click 
Accept All Mine or Accept All Others. 

4. To have your changes override all other changes and never see the Resolve 
Conflicts dialog box again, turn this feature off. 

How? 

1. On the Tools menu, click Share Workbook, and then click the Advanced
tab. 

2. Select the The changes being saved win check box. 
3. Click OK. 

5. To see how you or others resolved past conflicts, view this information on the 
History worksheet. 
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How? 

1. On the Tools menu, point to Track Changes, and then click Highlight 
Changes. 

2. In the When box, click All. 
3. Clear the Who and Where check boxes. 
4. Select the List changes on a new sheet check box, and then click OK. 
5. On the History worksheet, scroll to the right to view the Action Type and 

Losing Action columns. 

Conflicting changes that were kept show an Action Type of Won. The 
Losing Action column identifies the rows with information about the 
conflicting changes that weren't kept, including any deleted data. 

 Note   To save a copy of the workbook with all your changes, click Cancel in the 
Resolve Conflicts dialog box, click Save As on the File menu, and then type a new 
name for the file. 

For more information, click "About resolving conflicting changes in shared workbooks" in 
the See Also section of this article. 

Keep personal views and settings 

Excel saves a custom view of the shared workbook for you that includes information 
such as which worksheet you have displayed and your zoom settings. By default, your 
view includes any filter and print settings you make, or you can specify that you want to 
use the original filter and print settings. Each time you open the shared workbook, Excel 
displays it with your view in effect. 

Sharing workbooks makes it easier to collaborate on 
accounting functions 

As this example shows, you can have multiple users enter information in the same 
workbook at the same time — without giving up control of your formulas or workbook 
structure. You won't have to worry about users unintentionally or intentionally wreaking 
havoc on your workbook. And the people from whom you need input can add it when 
their schedules allow — not when a file is passed to them. 
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